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Tutorial 1: Machining a Gasket  
 
 

 

 

 

 

 
 

Using 2 ½ Axis Profiling  
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Introduction 
 
This tutorial will illustrate machining of a simple prismatic part such as this gasket using 2-1/2 
milling operations. Even though we have created a 3-D representation of the gasket, it will be 
seen later on that we can machine this using just 2-D curves (sketches). 
 
The reason we are able to do this is because of the prismatic nature of this model. 
 
The stepped instructions are accompanied by explanatory and introductory text. Reading this 
text will help you understand the tutorial methodology and provide information about additional 
options available.  
 
Don’t forget to save your work periodically! You may want to save the file under a different 
name so that the original file will be preserved. 
 
Strategy to Machine the Gasket 

 
• We will machine the Gasket by using a 2-½ axis machining operation called Profiling. 
• The part will be machined out of a 8 ½ x 5 x ¼ inch poplar wood sheet using a ½ inch 

Flat End Mill. 
• The wooden sheet will be held to the machine table or the spoil sheet on the table using 

double-sided tape. 
 
Main Programming Steps 
 
In creating programs for each setup, the following steps will be followed: 
 

• Create the Stock geometry 
• Set the Machine zero point or Locate geometry with respect to the machine coordinates 
• Create / Select the tool used for machining 
• Set the feeds and speeds 
• Set the clearance plane for the non-cutting transfer moves of the cutter 
• Select the machining regions for containing the cutter to specific areas to cut 
• Select the machining operations and set the parameters 
• Generate the toolpath 
• Simulate the toolpath. 
 

You may have to repeat either all or part of these steps for subsequent operations. 
 

Loading the Part Model 
 
Use the Alibre Design menu bar or the Standard toolbar buttons to create, load and save part 
geometry. 
 
New Part: Creates a new part. Though you can create your part with any units, Alibre CAM 
only accepts parts for which the units are in Inches or Millimeters. You can easily switch to 
these units when necessary by going to File > Properties > Units and selecting the applicable 
item under the Display Units section. 
Open: Loads Alibre Design parts or assemblies 
Import: Imports files created outside of Alibre Design. 
Save: Saves the current file.  
 



Getting Started with Alibre CAM 

12 

1. Select File / Open Part, or click the Open Part icon from the Alibre Design standard 
toolbar. 

 
 

2. From the Open dialog box, select the Gasket.AD_PRT file from the Tutorials folder in 
the Alibre CAM installation folder. (Default location C:\Program Files\MecSoft 
Corporation\Alibre CAM 2.0\Tutorials) 
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3. The loaded part appears as shown below. 

 

 
 

Note: You must work in shaded mode in order to be able to visualize toolpaths created in 
Alibre CAM.  It is suggested for best visual performance with Alibre CAM to work with only 
one view port open and the view port operating in shaded mode. 

Loading the Alibre CAM Browser 
 
1. Select Alibre CAM from the menu bar and click Machining Operations Browser. 
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The Alibre CAM browser (MOPs and Cutting Tools) is now loaded and is docked over the 
Design Explorer. You can toggle between the MOPs browser and the Design Explorer from 
the tabs at the bottom of the window. It can be hidden by un-checking Browser on the 
Alibre CAM menu bar. To re-display the hidden Browser window, you can re-check Browser 
from the Alibre CAM menu entry.  You can also resize it by dragging one of its sides. 
 

Preparing the Part for Machining 
 
The Setup tab allows the user to specify Machine Setup, Select Post Processor, Stock Geometry, 
Machine Coordinate System (Machine Zero) & Preferences. 

Setup Machine 
 

1. Click on the Setup tab located under the MOPs Browser and select Setup Machine 
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2. Set the Machine Type to 3 Axis. Click Ok Close the Setup Machine Dialog. 
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Set Post Options 
 

3. Select Set Post Options from the Setup tab. 

 
4. Set the current post processor that is on your controller. We will select Haas as the post 

processor for this exercise. Set the posted file extension type to .nc 
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Note: By default post processor files are located under  
C:\Program Files\MecSoft Corporation\Alibre CAM 2.0\Posts 
The program to send the posted output is set to notepad. This would output the G code to a 
notepad. 
 

Create/Load Stock 
 

5. Select Create / Load Stock from the Setup tab and choose Box Stock 

 
 

The stock model information dialog may be displayed when a stock geometry is created.  

 
User can turn off this dialog by selecting Do not show this dialog again located on the bottom of 
the message window.  

To display this dialog during stock creation, select Alibre CAM Preferences->Simulation 
Preferences and select Invoke ‘Stock Model Information’ dialog. 

 

6. This brings up the Box Stock parameters. Set the Length (L) = 8.50, Width W = 5.00 
and Height (H) = 0.125. Leave the other parameters as default and Click OK. 
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7. The stock geometry is now created, and a semi-transparent stock box is displayed on 
top of the part geometry. 
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Note: If the stock geometry is not visible, click Stock Visibility located on the status bar in the 
MOPs browser.  

 

 

Align Part and Stock 

Once the stock model is created, user can move the stock geometry relative to the part 
geometry and use the stock box to specify the machine zero (home position). 

 
8. Select Align Part and Stock from the Setup tab 

 
 

9. Set Z alignment to Top and XY alignment to Center. (This would align the stock to the 
top of the part in Z and center in XY) 
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Set Machine Coordinate System (MCS) 
 
The steps below help you determine the machine home (also know as machine zero or tool 
touch off point) for the part/stock geometry.  

The MCS is represented as a triad with 3 arrows, the Green arrow indicating X axis, Blue the Y 
axis and Red the Z axis. It is always a good practice to set the machine zero before generating 
a toolpath. 

 
1. Select Set MCS from the Setup tab. 

 
 

2. Switch to SetMCS Origin tab and choose Set to Stock Box, the Zero Face to Highest Z, 
and Zero Position to South West corner. This sets the machine home to the top of the 
stock material and the southwest corner of the part geometry. 
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(This sets the machine home to Southwest corner and top of the stock material). 
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Note: You can change the stock model transparency under standard mode by selecting 
Simulation Preferences that is located at the bottom of the MOps browser. 
 

Click Save As to save the work and specify a file name as Gasket-Rev1.  
 

Defining Cutting Tools 
Alibre CAM supports numerous types of milling and drilling tools. For each tool you can specify 
standard APT parameters: diameter, corner radius, flute length and tool length. Flute length is 
the cutting length, and Tool Length is the total length of the tool up to the tool holder. All 
defined tools can be viewed in the Tools tab of the Browser. You can also save a set of tools to 
an external folder that can be loaded in other files. 

Create Tools 
To machine the above part we will now create a ½ inch (0.5”) Flat End Mill. 
 

1. Go to the Cutting Tools browser that is located below the Alibre CAM-MOps browser and 
select Create/Edit Tools. Select the Tool Type to Flat End Mill.  

 

 

 
 

2. Set the tool name as FlatMill-0.5, Tool Diameter = 0.5, Under the Properties tab set 
Tool Number = 1.  
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Setting Feeds and Speeds 
 
You can assign Feeds & Speeds to a tool or you can load from a table. In this exercise, we will 
assign feeds and speeds to the tool. 
 

3. Switch to the Feeds & Speeds tab inside the create/select tool dialog. 
 

4. Use the following settings for feeds and speeds. 
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5. Click Save as New Tool. The tool is now created and listed under Tools in Library. Click 
OK to close the dialog.  

 

Note: You can edit the tool properties and click Save Edits to Tool to save the changes. You can 
create additional tools by assigning a different name and specify the tool parameters. 

 

The created tools are now listed under the Alibre CAM -Tools browser. 
 

 

Create Machining Operations 
 
“MOps” stands for Machining Operations. All machining operations you create are listed here, in 
order of creation. 
We will machine the Gasket in 2 steps using the 2 ½ Axis Profiling. Inner areas will be profiled 
first and then the outer area. 
 
In this process we will create a 2.5 axis profiling operation. 

 

1. Switch to the Create Operations tab in Alibre CAM-Mops browser. 
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2 ½ Axis Profiling 

2. Select 2 ½ Axis Milling and choose Profiling 

     

 

 
 

This brings up the 2 ½ Axis Profiling Operations dialog. We will go over the steps for creating 
the profile operations for the inner features of the Gasket. 

 

Select Machining Features/Regions 
 
Regions are sketches that already exist in your model, or separate new sketches you create 
within Alibre Design that coexist with your part, but do not contribute to its geometry (the 
sketch is not used for a feature). Regions serve different purposes in 2½ and 3 axis milling. 
In 2½ axis milling, however, regions determine the entire area to be milled. Part and stock 
geometry are not considered, and the tool always moves at a fixed Z level. Therefore, regions 
act as the drive curves, and their geometry is projected onto the stock. 
 
 

3. Go to the Machining Features/ Regions tab and click Select Containment Regions.  
The Profiling operation dialog is now minimized and allows selection of the sketch 
geometry. 
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We will not select the sketch to machine the 3 inner circles on the part. 

4. Switch to Design Explorer and select Sketch2.  
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Note: You can also select the sketch from Alibre Design View.  When select containment 
region is selected, Alibre CAM turns on Sketch selection filter to allow the user to select 
sketches. Hold the Shift key down to select multiple sketches. 
 

5. Click   to complete the selection.  
 

 

The 2 ½ Axis Profiling operation dialog comes back up displaying the selected regions 
(sketches). The selected regions are also highlighted on the part.  

 

 
 

Selecting the Tool 
 

6. Switch to the Tools tab inside the 2 ½ Axis Profiling operation. 
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7. Select the FlatMill-0.5. The 0.5” Flat End mill is now selected as the active tool and the 
Tool parameters are displayed to the right of the Tools window. 

 

Set Feeds and Speeds 
 

8. Click on the Feeds and Speeds tab. 

 



29 

3 

 
 

9. Select Load From Tool. Alibre CAM will now get the feeds and speeds information that 
was set when the tool was defined.  

 

Clearance Control 
 
The clearance plane is a horizontal plane (set Z level) from which the approach motions start 
and retract motions end. After retracting, the tool moves rapidly along this plane to the position 
of the next engage. This plane is typically a certain safe distance above the part geometry. 
 

10. Switch to Clearance Tab. 
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11. Set the Clearance Plane Definition to Automatic and Cut Transfer Method to Clearance 

Plane. 
 
Alibre CAM will determine a safe Z height for the Entry & Exit when set to automatic. Setting 
Cut Transfer to Clearance Plane would apply the automatic Z clearance between transfers when 
the tool moves from a machining region to another. 
 

Specifying Cut Parameters 
 

12. Switch to Cut Parameters tab 
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13. Set the Stock = 0 and under cut start Side check Use Outside/Inside for Closed Curves 

and select Inside. Alternatively you can also use Determine using 3D model. 
 

14. Select the Cut Levels Tab. Set Location of Cut Geometry At Top (the selected sketch is 
located at the top of the gasket) and specify the Total Cut Depth = 0.125. The cut depth 
is always set as an absolute value. 
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Entry/Exit 
 

15. Switch to Entry/Exit Tab and Set the Entry and Exit Type to None.  
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16. Click Generate. The 2½ Axis Profile toolpath is now generated and the Operation is listed 
under the Alibre CAM-MOps browser.  

 

Note: Toolpath display can be turned on/off by selecting Toolpath Visibility under the MOps 
browser. 
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1. Right mouse click on the 2.5 axis Profile operation and rename the operation to Inner 
Profile. 

 

Simulate Toolpath 

Make sure to turn on Stock Visibility under the Simulate tab.  
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1. Switch to Simulate tab, Select the 2 ½ Axis Profiling Operation and click   to launch 
the Alibre CAM Stock Simulation window. 

 

2. Click Simulate from the Stock Simulation window to run simulation. 
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Note: You can pause/stop, step, and skip the simulation using the controls available on the 
simulation window. To control the simulation speed, select Simulation Settings from the 
Stock Simulation window. 

3. Once the simulation is complete, you can close the Stock Simulation window and return 
to the Alibre CAM browser.  

Creating the Outer Profile Toolpath 
We will not create a 2 ½ Axis Profiling toolpath to cut out the Gasket. Having created a profiling 
toolpath for the inner region, we will use the same Tool (FlatMill-0.5) and settings for Feeds 
/Speeds and Clearance plane. 
 

1. Switch to the Create Operation tab. 
 

2. Select Profiling from the 2 ½ Axis operations menu. 
 

3. Under Machining Features/ Regions, select Remove All. 
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4. Now click on Select Curves as Regions and select Sketch3 by switching over to the 

Design Explorer to select the outer profile of the Gasket as the region. 
 

  
 
You can also select the sketch by clicking on the edge of the part from Alibre Design 
View.   
 

5. Click  to complete the selection. 
 

6. Switch to Tools tab and select FlatMill-0.5 as the active tool.  
 

7. Under Feeds/Speeds select Load from Tool. 
 

8. Set the Clearance control to Automatic. 
 

9. Switch to Cut Parameters tab, check Use Outside/Inside for Closed Curves, and 
set the Cut Start Side to Outside 

 

 
10. Go over to Cut Levels and set the Total Cut Depth = 0.125. 
 

11. Click Generate to Create the 2 ½ Axis Profile Toolpath. 
 

The 2 ½ Axis Profile Operation is now created and is listed in the MOps Browser. 
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Simulate Toolpath 
 

Make sure to turn on Stock Visibility under the Simulate tab.  
 

 

1. Switch to Simulate tab, Select the 2nd 2 ½ Axis Profiling Operation and click   to 
launch the Alibre CAM Stock Simulation window. 
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2. Click Simulate from the Stock Simulation window to run simulation. 
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3. Once the simulation is complete, you can close the Stock Simulation window and return 
to the Alibre CAM browser. 

Reports 
 

1. Switch to Create Operations Tab.  
 

2. Select the MOp Set1 and right click and select Information. 
 

 

This provides the estimated machining time for the operations created under MOp Set1. 

Note: You can also go over to Machining Operations and right click and select information 
determine the estimated machining time for all the MOp Sets.  
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Shop Docs 
 
Shop documentation can be generated selecting Machining Operations under the Create 
Operations tab.  Right mouse click and Shop Documentation. 
User can select from one of the 2 templates and generate shop documentation. This is saved as 
an html file and can be printed and handed over to the operator in preparation for the part to 
be machined on the CNC. 
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Post Processing 
 
Once the toolpath has been generated, it can be post-processed to a specific machine 
controller. Alibre CAM comes with a set of post-processors to choose from. Each post-processor 
is represented by an *.spm file, all of which are located in the Posts folder under the Alibre 
CAM installation folder. 
 

1. Select Machining Operations from the Create Operations tab and right click and 
select Post Process / Post All. 

 

 
 

2. Specify the File Name as Gasket.nc and click Save. 
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The post by default is set to Haas as specified under the Post processor setup. You can change 
the post processor by selecting a different one from the drop down menu in the list. The posted 
g code by default will be saved to the folder where the part file is located. 

    Lista Studio srl      www.lista.it          info@lista.it 
 

 


